Copyright Notice

This manual describes software that contains published and unpublished works of authorship proprietary to EZCAM Solutions, Inc. It is made available for use and maintenance of our products. Under copyright laws, this manual, or the software it describes may not be copied in whole, or in part, without prior written consent of EZCAM Solutions, Inc., except in normal software use. The information in this document is subject to change without notice and should not be construed as a commitment by EZCAM Solutions, Inc.

All software package identifying names appearing herein prefaced with EZ are trademarks of EZCAM Solutions, Inc., All Rights Reserved.

EZ-CAM® and any other references to EZCAM applications software are protected by

Copyright 1999-2003 of EZCAM Solutions, Inc.
All Rights Reserved.

Printed Documentation
Copyright 1999-2003 of EZCAM Solutions, Inc.
All Rights Reserved.
CHAPTER 2.  
EZ-MILL EXPRESS TUTORIAL 1

OVERVIEW
This tutorial is intended for users with little, or no experience in EZ-Mill Express operations. The step-by-step instructions in this tutorial describe the entire process of creating an NC (Numerical Control) program for a sample part.

Throughout the tutorial you will find important notes, tips or references to the Express online help where additional information on the commands and functions is provided. We also display the associated shortcut icon of any commands used in the tutorials.

Tutorial #1 is set up in Inch!

Here's the blueprint of the sample part that will be used for this tutorial.
**Basic Programming Steps**

Before we continue with the tutorial let us explain the basic steps needed to create a part program with EZ-Mill Express.

**STEP 1.** Create Geometry
Start by creating part geometry via commands under the Geometry menu, or alternatively, use “File/Open” command to import an IGES, DXF or DWG geometry file from another CAD system.

**STEP 2.** Create a New Work Step and set Machining Parameters
Define a new Work Step and apply the machining parameters as required by type of operation and feature used.

**STEP 3.** Define Toolpath for new Work Step
Use the “Work Step / Define Path” menu commands like CHAIN, ARC, LINEAR, etc. to track and follow existing geometry to define the path that is to be machined by the tool.

**STEP 4.** Verify Toolpath for new Work Step
Visualize the computed toolpath to assure correct tool operation and proper setting of machining parameters.

⚠️ Repeat STEP 2 – STEP 4 for every Work Step until part is finished

**STEP 5.** Post G-code
Select the “Postprocessor” related to the type of control and machine where the program will run and let the software create the G-Code file.
**REQUIRED MACHINING OPERATIONS**

The following machining operations are necessary to produce this part:

- Mill the exterior profile using a 1/2-inch end mill.
- Mill the center pocket with a 1/2-inch end mill.
- Drill two 5/8-inch diameter holes.
- Tap-drill eight holes using a #7 (.201-inch) drill.
- Tap the eight holes using a 1/4-20 tap.

**Setting BUTTON Layout**

This tutorial references buttons that may not be on your default button layout. In order to assure that they are available, Click “View” menu, “Customize Buttons” and “Reset”. Don’t be intimidated by all of the icons. You can use the pull-down menus instead if you wish. Normally, new users will learn the software using the English pull-down menu commands first and observe which shortcut buttons correspond to them. After becoming proficient, users typically use the shortcut buttons for faster access to commands. This tutorial will reference the menus and button icons so that you also learn the more common buttons faster.

**Setting Origin, Window Size and Location**

The window size is the distance from the edge of the window to the center of the window. The window location is the signed, absolute position of the window center from the part’s origin. The viewing parameters that are found in the Setup dialog box specify the size and location of the window. Note that you would not normally perform this step in programming a part, but it is necessary here to insure clarity in following the tutorial. Normally, you would just use the Zoom/Fade commands to set the window size as needed.
SELECTING AN ORIGIN FOR THE PART

When selecting the origin for the part, choose a location that is referenced by the part’s dimensions. The origin should be selected before defining the window location, because the window center is referenced from the part’s origin. The graphic in Picture 2-2 below shows the location of the part origin for this exercise (X = 0, Y = 0).

![Diagram showing the location of the part origin for an exercise with X = 0, Y = 0. The window size is 3.500, the X center is 1.750, and the Y center is 1.500. The window center is also indicated.](Picture 2-2)
SETTING PREFERENCES AND WINDOW SIZE

Before continuing with the construction of the sample part, several parameters should be set so that the system is compatible with the instructions in this tutorial. Also the size of the workspace should be set. The sample part is 6 inches in the X-axis and 5.5 inches in the Y-axis. Because of the size of the part, it is not convenient to work in the default window; therefore, the window settings should be changed as follows:

1. Select "New" command from the “File” menu to restart EZ-CAM and the clear the memory before continuing with the tutorial. Make sure that the “MILL” button is activated before pressing OK to start over.

2. Type “1.75” for “X Center”, “1.5” for “Y Center” and “3.5” for “Size”.
   (This sets the window size from the edge of the window to the center of the window, allowing enough room to see all of the part as it is created. See Picture 2-2.

3. Select “Inch” option button as the parts input dimension system.
4. Click the “Background” list box and select “Black”.

5. Check the box "Blank Verify" on the right.

6. Check the box "Save as Default".

7. After the preferences have been correctly set, click OK.

The initial setup for this tutorial is now complete. Continue with the next section to create the geometry necessary for this part.

All dialog input fields that expect numerical input also accept the use of mathematical functions to calculate the desired values. See “Value Entry Box” section in the online help for more information.
PART GEOMETRY
Now that the viewport has been adjusted to accommodate the part, the creation of the part can begin. This involves creating geometry that is used to define the tool paths for machining the part. The geometry is created first, so that the process of creating the tool paths is greatly simplified. Before you begin check that the actual view is set to X-Y.

To change system view to X-Y, click the X-Y view button.

CREATING CONTOUR GEOMETRY
First, we will define the geometry that defines the outside contour of the sample part. This includes the two circles that define the lower profile corners, and the tangent lines in between. At any time you may use the Undo/Redo buttons in the upper left corner to correct any mistakes you make.

DEFINING TWO CIRCLES
Follow these steps to create two circles that define the lower portion of the sample part.

1. Select the “Circle/Arc, Center, Radius” button.

2. For the Radius of the first circle, type “1.25” in the “R” field of the “Value Entry Box” on the lower right side of the EZ-Mill Express screen. Make sure the X, Y, Z coordinate values are set to “0” (the default value).
3. Press the ENTER button. (The first circle should be displayed at the part origin (intersection of the X and Y-axes).

4. For the Radius of the second circle, type “.75” in the “R” field of the Value Entry Box, then press Tab to move the focus to the “X” input field.

5. Type “4” for the Center X location, then press Tab and type “-.5” for the Center Y location. Press the ENTER button. The two circles should be displayed as shown in Picture 2-3.

---

**DEFINING TANGENT LINE**

The next step is to define a tangent line to connect the 1.25 and .75-inch radius circles.

1. First select the “Line, Two Points”, then the “Tangency” button.

2. Then the "Pick First Point" prompt displays in the message area, click just below the 1.25-inch radius circle (large circle on the left) as shown in the graphic below.

3. Now move the cursor to the right, just below the .75-inch radius circle. When the "Pick Second Point" prompt displays, click below this circle. A line is drawn tangent to the 1.25 and .75-inch radius circles. See Picture 2-4.
DEFINING PARALLEL LINE

The next step is to define a line that lies parallel to the Y-axis and tangential to the .75 inch radius circles.

1. First select the “Line, Parallel” button.

2. For the parallel distance type “4.75” in the “D” field of the “Value Entry Box”. (Do not press ENTER).

3. Move the cursor to the right side of the systems Y-axis coordinate handle as shown in Picture 2-5. The geometry preview will show you a line parallel to the Y-axis with a distance of 4.75 inch. If the preview is OK confirm with a mouse click.
Because the cursor position is very important when using the “Line, Parallel” function, use this example to gain some experience by moving the cursor over the coordinate system handles or any existing line and watch the results displayed by the dynamic preview.
**CREATING LINE AT ANGLE**

The next step is to define a line that lies tangential to the 1.25-inch radius circle at an angle of 35 degrees to the X-axis.

1. Select the “Line At Angle” button.

2. Click the X-axis coordinate system handle with the mouse to define the reference axis for the angle.

   ![Cursor Position to select X Axis](image)

   For the angle “reference axis” you can select the coordinate system’s X or Y-axis as well as any other existing line. The dynamic preview will help you to get the correct selection by displaying the angled line according to the actual angle specified in the “Value Entry Box”.

3. Type “35” in the “A” field of the “Value Entry Box” (Do not press ENTER).

4. Select the “Tangency” button.

5. Move the cursor to a position slightly above the 1.25 inch circle as shown in Picture 2-6. The geometry preview will show the new line. If it is OK confirm the action with a mouse click. The result should look like Picture 2-6.
When using “Tangency” function, the cursor position (above or below, left or right) is very important. Move the cursor over the circles in Picture 2-6 and watch the various results displayed by the dynamic preview.
**Defining Tangential Circle**

Follow these steps to create the circle that fills the corner of the two new lines. This is accomplished by specifying the radius and two points that lie tangential on both lines. For the result see Picture 2-7.

1. Select the “Circle/Arc, Two Points, Radius” button.

   ![Circle/Arc, Two Points, Radius]

2. For the Radius type “0.75” in the “R” field of the “Value Entry Box”.

3. Select the “Tangency” button.

   ![Tangency]

4. Move the cursor to position 1 as shown in Picture 2-7 and click the mouse. The vertical line will be displayed in dotted style. Now move the cursor to position 2 inside the angled line. The geometry preview will show the new circle when moving the cursor to the new position. Confirm the action with a mouse click. The result should look like Picture 2-7. As explained in earlier steps of the tutorial, the cursor position plays a very important role when using “Tangency” function. Here it is important to select the existing lines on the “inside” where the position of the new circle is expected to be.

![Cursor Positions to select tangential Points]

**Picture 2-7**


**REMOVING LINE SEGMENTS**

Follow the instructions below to remove some of the line segments.

1. Click the “Remove to Closest” button. This command will allow you to remove a segment of a line, arc, or circle between the closest boundaries.

![Remove to Closest](image)

2. At the "Pick Line, Arc or Circle" prompt, choose the line segments to be removed as shown in Picture 2-8.

![Picture 2-8](image)
**CREATING PARALLEL LINES FOR POCKET GEOMETRY**

The blueprint for the sample part specifies that the inside pocket is offset 0.5 inches from the outside contour. To create the pocket boundary, parallel lines must be offset 0.5 inches from the contour geometry lines.

1. Click the “Offset” button.

2. When the value entry box prompts for an offset value, type “.5” in the “D” field. (Do not press ENTER)

3. When the "Pick Line" prompt displays, select each of the three existing lines as shown in Picture 2-9, one at a time, by moving the cursor to the inside of each line, then click the mouse. The geometry preview will help you to determine the correct positions. The result is shown in Picture 2-10.
The “Offset” command automatically snaps to the geometry element (line or arc) next to the cursor and offsets this element by the given distance to the side specified by cursor position. See online help for more information about “Offset” command.
**Removing Circle Segments**

Follow the instructions below to remove some unnecessary circle segments.

1. Click the “Remove to Closest” button.

2. At the "Pick Line, Arc or Circle" prompt, select the circle segments as shown in **Picture 2-11**. The result is shown in **Picture 2-12**.

---

**Picture 2-11**

---
**CREATING CORNER FILLETS IN POCKET**

Now we're going to create corner fillets within the pocket.

1. Click the “Corner Fillet” button.

2. When the value entry box prompts for a radius value, type “0.375” in the “R” field.

3. At the "Pick int. of two lines, arcs or circles" prompt, start with the lower left-hand corner inside the pocket. Pausing the mouse over the corner without clicking, the dynamic preview will show the fillet to be inserted. Clicking there will actually insert the fillet. See *Picture 2-13*. 
4. Continue as shown in Picture 2-14 in a counterclockwise direction selecting each corner, placing the cursor inside each corner, until the pocket is completely defined. The finished profile is shown in Picture 2-15.
If you want to save the newly created geometry before continuing, jump to the “Saving the Part” section at the end of the tutorial.

**Important!**

It is not possible to save part data with the software running in evaluation mode.
Creating the Part Program

Now that the geometry for the sample part is finished it is necessary to create a part program consisting of one or more Work Steps to machine the part. Create the Work by selecting a feature (Contour, Pocket, Holes, etc.) and specifying associated tool settings/machining parameters. Then use the commands located in the “Work Step/Define Path” menu to assign a path that will be machined applying the previously defined feature settings. After verifying the cutter path to assure correct tool operation continue with the next Work Step. Finally, when all necessary Work Steps have been defined, you can go to the next step and create the CNC-Code.

Execution of the Work Steps will be in the same order they have been created. You can use the integrated spreadsheet to perform operations such as moving, reordering or deleting existing Work Steps.

See the “Spreadsheet” book in the online help for more detailed information.

The Part Program section of the Express Tutorial #1 is kept very easy with only a few of the Work Steps normally necessary to machine such a part in real life. This way it is easier for beginners to understand the way of working with EZ-Mill Express and to get a compressed overview about how to create Work Steps and make use of the machining features. More advanced Technologies like Roughing & Finishing or combining and reordering Work Steps will be explained later in an additional tutorial. Also a lot of parameters and settings available in the software will never be touched in this tutorial assuming that the default values will fit the needs. Of course, each feature dialog has a button labeled “Advanced”. If necessary this button brings you to the full machining dialog where you can modify nearly everything.

Use the Help button on the feature dialogs to get more information about the settings.
The part program of Tutorial #1 will consist of these five Work Steps:

1. Mill the exterior profile using a 1/2-inch end mill.
2. Mill the center pocket with a 1/2-inch end mill.
3. Drill two 5/8-inch diameter holes.
4. Tap-drill eight holes using a #7 (.201-inch) drill.
5. Tap the eight holes using a 1/4-20 tap.

The Work Step “Path”

Before we continue with the part programming lets us give you a short explanation about what a “path” is. Each Work Step needs a profile or shape the tool will have follow in some way. Therefore a “path” has to be assigned to every Work Step following certain rules determined by the selected feature (Contour, Pocket, Holes, etc.). For example it is allowed to define an open path when using the “Contour” feature, whereas a “Pocket” path always has to be closed.

Related to the way a path is created the features are categorized into two types. The “Contour”, “Pocket” and “Holes” feature need a path manually defined using the “Define Path” commands (Chain, Linear, Rapid, etc.) located in the “Work Step” menu. “Hole Pattern” and “Lettering” features automatically create their own path based on the parameters specified through the user dialogs. This also affects editing of existing paths. Manually defined path’s are edited using “Define Path” commands like “Delete All Links” or “Reverse Direction” while a path based on “Hole Pattern” or “Lettering” feature is changed only by alternating parameters using the user dialogs.

See the “Creating and Editing Work Step Path” book in the online help for more detailed information.
CREATING WORK STEP #1 (OUTSIDE PROFILE)

Now let's create the first Work Step to machine the exterior profile using the Express “Contour” feature. We will use a 1/2-inch end mill to machine the outside profile in clockwise direction up to the depth of 1 inch, stepping down in increments of 0.25 inch. We also use of the automatic Ramp/Lead option that will calculate Ramp and Lead moves at beginning and end of the profile based on the specified cutter diameter.

1. Select “New Contour” feature in the “Work Step” menu. Input the values in the appropriate fields, set “Offset Dir” to “left” and check the “Lead In/Out” option as shown in Picture 2-16. Close the dialog using the OK button.

![Picture 2-16]
2. Now we use the “Chain” command to define the path for the first Work Step. Select “Chain” from the “Work Step / Define Path” menu or click the corresponding button.

The “Chain” command is used for path creation whenever possible. Beside the fact that it is very easy to use it will also detect gaps in the contour. This function provides additional safety in order to get correct machining results. See the Express online help for more detailed information about “Chain” command.

3. The prompt "Select First Line or Arc" is displayed at the bottom edge of the window. Move the cursor to Position as shown in Picture 2-17 and double-click the mouse at nearby the start of the 1.25-inch radius circle to select the circle as the first element in the path chain.

The software automatically completes the path by following the connecting geometry elements from the first point to the last. The position where the first element is selected is very important to the direction of the path. The path between the selected elements is automatically completed by the software and displayed in a blue color as shown in Picture 2-18. A small arrow referred to as the “direction indicator“ visualizes the path direction.
Cursor Position to double-click the first "Chain" Element

Work Step #1 Path Startpoint and path direction indicator
4. To ensure that the first Work Step was created correctly, it must be verified. First switch to “Isometric View” using the corresponding command button. Then click the “Verify” button. The system calculates the cutter path, with the ramp and lead moves as shown in Picture 2-19. The tool cuts around the part four times in the clockwise direction, stepping down the $\frac{1}{4}$ inch we specified at each pass.

This Work Step is now complete. Hit the Redraw button to refresh the screen and remove the verified toolpath display.

When finished, you should switch back to X-Y view using the button.
**Creating Work Step #2 (Inside Pocket)**

Now we create the second Work Step to machine the pocket profile using the “Pocket“ feature. We use a second 1/2-inch end mill to machine the pocket up to the depth of .75-inch, stepping down in increments of .25-inch. When defining the pocket path we show you how control the plunge point for a pocket cycle by placing a rapid move at the start of the path.

1. Select “New Pocket” feature in the “Work Step” menu and input the values in the appropriate fields as shown in Picture 2-20. Close the dialog using the OK button.

![Picture 2-20]

Picture 2-20
2. Now we create the pocket path for the second Work Step. To control the plunge point we will first define a rapid move connecting the desired plunge location with the pocket profile. Click the “Rapid” button or select the command in the “Work Step /Define Path” menu.

![Rapid]

If the rapid move is omitted, EZ-Mill Express will calculate its own plunge point and automatically create a point entity to mark the plunge location when the toolpath is verified. This point entity can later be used to create a “pre-drilling” Work Step.

3. To define the start of the rapid move type “2.0” in the “X” and “0” in the “Y” field of the “Value Entry Box”. Make sure the Z coordinate value is also set to “0”. Then press the ENTER button.

4. Next select the “Snap All” pick mode and move the cursor to the position shown in Picture 2-21 to select the intersection of the horizontal line and the 1.25 –inch circle as the endpoint of the rapid move.

![Snap All]

![Picture 2-21]
5. Click the “Chain” button or select the command in the “Work Step /Define Path” menu to continue definition of the pocket path.

6. The prompt "Select First Line or Arc" is displayed at the bottom edge of the window. Move the cursor to Position as shown in Picture 2-22 and double-click the mouse at the start of the fillet circle as the first element in the path chain. The software automatically completes the path by following the connecting geometry elements form the first point to the last. The completed path is shown in Picture 2-23.
CHAPTER 2

Please note that there may be more than one “direction indicators” within the same path. The first indicator is always at the first point of the path. More arrows will be displayed on the first point of every element following a rapid move.

7. Verify the second Work Step to ensure that it was created correctly. Switch to three-dimensional view using the “Isometric View” command button. Then click the “Verify” button. The system calculates the cutter path as shown in Picture 2-24 below. The tool cuts inside the pocket using a cutting pattern parallel to the pockets profile and stepping down the ¼ inch we specified at each pass.

Verify Isometric View
The second Work Step is now complete. Hit the Redraw button \( \text{Redraw} \) to refresh the screen and remove the verified toolpath display.

Switch back to X-Y view using the \( \text{X-Y view} \) button.
Creating Work Step #3 (Drilling .625 Dia Holes)

As the milling Work Steps are completed we continue with machining the two .625 diameter holes. We use the “Holes” feature in combination with a chip break drilling cycle. This feature is normally used every time when there is no specific drilling pattern that can be handled by the “Hole Pattern” feature (rectangular, arc or circular pattern). The path will be defined manually by selecting each position using the cursor.

1. Choose “New Holes” feature in the “Work Step” menu, select the “Chip Break” cycle and input the values in the appropriate fields as shown in Picture 2-25. The depth can be typed as $1 + .625 \times .3 + .05$ (or 1.2375) in order to achieve a drilling depth of 1.2375. The number 1 signifies the part thickness in inches, .625 is the tool diameter, .3 is the factor for computing the length of the drill tip and .05 is the overshoot of 50 thousandths of an inch. Close the dialog using the OK button.

![Picture 2-25](image-url)
2. To create the path for the two .625 DIA drilling locations of the third Work Step, click the “Linear” button or select the command in the “Work Step /Define Path” menu.

3. Next select the “Center Circle” pick mode and move the cursor to the positions as shown in Picture 2-26 in order to select the center coordinates of the existing arcs. The geometry preview will help you as it automatically snaps to the center when moving the cursor above each of the arcs. Click at each position to select the coordinates for the new drilling path. The finished path can be seen in Picture 2-27.
4. For Verification switch to “Isometric View” and click the “Verify” button. The system calculates the tool path as shown in Picture 2-28.
CREATING WORK STEP #4 (DRILLING TAP HOLES)

In the fourth Work Step eight .201 DIA tap holes around the center of the 1.5–inch circle have to be drilled. We will use the “Hole Pattern” feature in combination with a chip break drilling cycle. This feature provides predefined patterns like rectangle, circle or arc and automatically creates the path when the dialog is closed using the OK button.

1. Select “New Hole Pattern” feature in the “Work Step” menu and input the values in the appropriate fields as shown in Picture 2-29. Close the dialog using the OK button.

![Picture 2-29](image-url)
2. For Verification switch to “Isometric View” and click the “Verify” button. The system calculates the tool path as shown in Picture 2-30.

![Verify Isometric View](image)

To edit the path of a Work Step using the “Hole Pattern” or “Lettering” feature simply re-open the feature dialog by double-clicking the corresponding Work Step entry in the list box. Change the values and close the dialog using OK button. The toolpath will be recalculated based on the new settings.
**CREATING WORK STEP #5 (1/4-20 TAP)**

In the fifth and last Work Step we will tap the eight ¼-20 holes already drilled in the previous Work Step. Again we will use the “Hole Pattern” feature in combination with the tap cycle.

1. Select “New Hole Pattern” feature in the “Work Step” menu. Select the “TAP” cycle and input the values in the appropriate fields as shown in Picture 2-31. Close the dialog using the OK button.

![Picture 2-31](image-url)
2. For Verification switch to “Isometric View” and click the “Verify” button. The system calculates the tool path as shown in Picture 2-32.

![Verify Isometric View](image)

**Picture 2-32**

**ESTIMATING TOTAL MACHINING TIME**

The “Verify All” command in the “Post” menu is used to estimate the total time it will take to machine the part. It automatically performs an on-screen verification of all of the part program Work Steps in memory, in the machining order. The total machining time (not including rapid traverse or tool change time) is displayed in a dialog box at the end of the verification process. To close the dialog click OK.
**SAVING THE PART**

It is very important to save the newly created or edited part from memory to disk periodically during a session as well as at the end to ensure that no information is lost. The EZ-CAM “Save” and “Save as” commands under the File menu transfer files from system memory to a hard disk or other media.

1. Select “Save as” command from the “File” menu.

2. Select the appropriate drive and folder where your part file(s) should be stored. You can use the “EZCAMW\MILLPARTS” folder that is automatically created by the setup routine.

3. Select the type of data you want to store in the “Save as type” list box.

4. Type the new filename “Tutorial1” in the File Name box. The file extension is automatically added.

5. Click the “Save” button.

It is not possible to save data when the software is running in evaluation mode. The “Save” and “Save as” commands are disabled. Continue with the next step in the tutorial.
**CREATING CNC CODE**

Now that the part program has been created, it must be converted to run on a NC control by running the “Post” command with the appropriate “Post-Processor” for your machine.

The CNC data file or “Post-Processor” is used as a “template” to format the part program data file that was created in EZ-Mill Express. This template consists of program formats (e.g., TOOL CHANGE, LINEAR MOVE, RAPID MOVE, etc.) that determine the structure of a part program for a specific CNC. To create or edit a “Post-Processor” a special editor called “MBuild” is required.

1. Select “Post” command in the “Post” menu. This will open the “Post Process” dialog.

2. First a postprocessor has to be loaded. If the one desired is already loaded and displayed in the section “CNC-File” continue to the next step. Otherwise use the “Change” button to browse your system for a different postprocessor.
Standard postprocessor directories created by the EZ-Mill Express setup:

**INCH**<br>&lt;DRIVE&gt;:\EZCAMW\EZCAMX13\MILLINCHPOST

**METRIC**<br>&lt;DRIVE&gt;:\EZCAMW\EZCAMX13\MILLMETRICPOST

3. Activate (check) the “**G-Code**” option. The computed program text will be displayed on the screen.

4. Activate (check) the “**EZ-DNC**” option. This will automatically start the “EZ-DNC” application when posting of the part file is finished and load the newly created file for sending it to the machine using the serial port. See Chapter 5 “Communication with the Control” for more information about EZ-DNC.

5. Next is the G-Code File” section. Here the default name and directory for the computed program file is displayed. The name is taken from the part file that was saved before. The default directory is “EZCAMW\MILLGCODE”.

Ensure that part file and postprocessor share the same dimension unit (“Metric” for this tutorial). The system will generate a “Dimension Unit Conflict” message, but then automatically scale the NC-Code according to the dimension specified in the postprocessor. See Express online help for more information about the “Setup” dialog located in the “View” menu.

6. Click the “Post” to start posting. The Processing window will be displayed showing messages followed by listings of ASCII code created. When all Work Steps have been processed, a final message dialog box is shown.
When the software is running in evaluation mode only the first 15 lines of each Work Step and a total of 75 lines per program are posted and saved.

7. Click OK to close the message dialog box. To close the Processing window, press ESC or click [X] at the top right-hand corner of the Processing window.

![Image of post processing output]

Congratulations! You've completed the first tutorial!